
MMC Tutorial
If you’ve not used the Microsoft Management Console (MMC) before, this tutorial will help 
get you up and running quickly. Additionally, if you’ve only used the MMC in the form of
Windows’s preconfigured consoles, this tutorial will help you take advantage of some of the
MMC’s more advanced features, such as task pads and views.

The MMC is a stripped-down interface that looks very similar to the Windows Explorer. It
includes a right pane with a tree view and a left pane for details. By itself, the MMC does
practically nothing. Instead, it relies on various modules, called snap-ins, to provide various
types of administrative functionality. In this way, the MMC is a bit like a video game console.
By itself, it’s not much fun. But once you snap in a game cartridge, you can have a great time!
Figure 1 shows the blank MMC screen, which you can see by selecting Run from the Start
menu of your computer, typing MMC, and clicking OK.

Figure 1

All the Windows 2000 administrative tools are nothing more than preconfigured MMC
consoles. A console is a collection of one or more snap-ins, allowing you to work with many
administrative tasks from the same window. Figure 2 shows the Windows 2000 Computer
Management console, which includes several snap-ins.

Each of the major items in the right tree view is a snap-in. Selecting a snap-in causes the
MMC to display the snap-in’s properties in the left pane.

Why was the MMC invented? When Windows NT 3.51 and 4.0 were the major Microsoft oper-
ating systems, Microsoft received a lot of complaints that the administrative tools were too
spread out. Administrators had to deal with completely separate programs for managing
DHCP, SQL Server, DNS, IIS, and other functions. The MMC provides a consolidated place 
for all administrative tools, all of which share a similar look and feel. This enables an 



administrator to more easily learn new administrative tools and provides a single place for
enterprise-wide administration.

Figure 2

The MMC was designed to be easy to use. If you don’t want to take any time to configure the
MMC, you can use the preconfigured consoles Windows 2000 and every .NET Server product
sets up for you. Application Center 2000, for example, creates a default Application Center con-
sole in the Administrative Tools program group on the Start menu. But using the default con-
soles is not much better than using the individual administrative tools provided with Windows
NT 4.0. To take advantage of the MMC, you need to learn how to configure your own custom
consoles.

Starting the MMC
Every MMC runs in one of four modes:

• Author—In this mode, you can make changes to the console configuration by adding
and removing snap-ins and configuring task pads.

• User - Full Access—This mode allows a user to do any administrative tasks he wants
to with the console, but it prevents him from adding or removing snap-ins. This is the
mode most preconfigured consoles run in.

• User - Limited Access, Multiple Windows—In this mode, a user can see only the por-
tions of the console that were visible when it was saved. He can create new windows
within the console, but he cannot close existing ones.

• User - Limited Access, Single Window—In this mode, a user can see only the por-
tions of the console that were visible when it was saved. He cannot open new windows or
close existing ones.



These modes allow you to configure your own consoles and distribute them to other adminis-
trators. Configured in the correct mode, you can prevent those administrators from accessing
specific areas of functionality and from modifying the console configuration. This is useful for
distributing consoles to help desk administrators, for example.

If you are in Author mode, you can configure the console’s mode by selecting Options from the
Console menu. As shown in Figure 3, the mode is selected from a drop-down list box.

Figure 3

To start the MMC in author mode, select Run from the Start menu, type MMC, and click OK.
You’ll start with a blank console that you can begin customizing to suit your needs.

Loading Snap-ins
The first step in customizing your console is to add the snap-ins that correspond to the admin-
istrative functionality you need. To load or remove snap-ins from a console, follow these steps:

1. Open a blank console by selecting Run from the Start menu, typing MMC, and 
clicking OK.

2. Select Add/Remove Snap-in from the Console menu. The Add/Remove Snap-in window
appears. The window is blank because your console doesn’t currently contain any snap-
ins. If it did, you could remove or modify them here.

3. Click the Add button to display the Add Standalone Snap-in window.

4. Double-click a snap-in to add it to the console. Depending on the snap-ins you select, you
might be prompted for additional information, such as the name of the computer to
which you want the snap-in to connect.



5. After you have finished adding snap-ins, click Close. This returns you to the
Add/Remove Snap-in window, which now displays a list of the snap-ins that have been
added to your console.

Note Some snap-ins contain extensions. For example, the Computer Management snap-in
contains extensions for the Device Manager, Disk Defragmenter, and so on.
Extensions are “sub snap-ins” that depend on the main snap-in to work. If you
select a snap-in in the Add/Remove Snap-in window, you can click the Extensions
tab to view the selected snap-in’s extensions. By default, all extensions associated
with a snap-in are added to the console. You can change this by clearing the appro-
priate check box on the Extensions tab. Doing so allows you to determine which
extensions will appear in your console.

6. Click OK to close the Add/Remove Snap-in window. You will return to the main MMC
window, which now shows the snap-ins you have added.

Saving a Console
After you’ve taken the time to create a custom console, be sure to save it. That way, you’ll be
able to return to your custom console whenever you need to. Consoles can be saved by select-
ing Save As from the Console menu. Consoles are saved in files with an .MSC extension, and
you can double-click an .MSC file to automatically launch the MMC and open the console.

Opening a New Window
If you create a console with many snap-ins, at some point you might want to view the details
of two snap-ins simultaneously. Normally, of course, you can’t do that. Whenever you select a
snap-in, the details pane of the MMC changes to the details of the currently selected snap-in.

Instead, the MMC enables you to open multiple windows. Each window runs within the main
MMC window and contains the same snap-ins as the first window. The console must not be
running in User - Limited, Single Window mode for multiple windows to be available.

To open a new window, select New Window from the Window menu. Figure 4 shows a custom
MMC console with two windows open. Each window is pointed at a different snap-in, so two
sets of details can be viewed simultaneously.

Using the Action Menu
The Action menu changes depending on what’s selected in the MMC. Every object in the MMC
has a list of actions associated with it. You can right-click the object to display its actions in a
pop-up menu, or you can select the object and find its actions on the Action menu.



Figure 4

Using the View Menu
The View menu enables you to make changes to the appearance of the console and the snap-
ins it contains. You have the following options:

• Choose Columns—This feature enables you to choose which columns appear in the
details pane of the MMC. You can display more information or less information, as is
appropriate to your administrative needs.

• Large Icons—This feature provides a large icon view in the details pane.

• Small Icons—This feature provides a small icon view in the details pane.

• List—This feature provides a list view in the details pane.

• Detail—This feature provides a detailed, columnar view in the details pane.

• Advanced—This feature turns on advanced information features of the console. This
makes certain configuration information, such as security, available in some snap-ins.
Not all snap-ins have advanced configuration information, so this feature is not always
have an effect.

• Filter—Some snap-ins have a filter option that lets you restrict the view to specific
types of information. For example, the DNS snap-in allows you to filter the details pane
so that it displays only certain types of records, making a large DNS database easier to
work with.

• Customize—This option enables you to access the Customize View window. You can use
the check boxes in this window to customize the console appearance by eliminating the
tree view, standard menus, the status bar, the toolbar, the description bar, or task pad
navigation tabs.



Using Favorites
The MMC supports a Favorites feature, which enables you to jump to a particular area of a
console with a single click. You can use this to quickly move to the most important administra-
tive tasks you need to perform.

To add an item to you Favorites list, select the item in the MMC and select Add to Favorites
from the Favorites menu. To jump to a favorite item, just select it from the Favorites menu.

You can also select Organize Favorites from the Favorites menu to call up a simple organiza-
tion window. This window enables you to create subfolders for your favorites, much like you
would in Internet Explorer.

Creating Task Pads
Task pads are a special type of view that the MMC offers. Task pads are designed to group
several related administrative functions in a single, easy-to-use screen for less experienced
administrative personnel. They offer a great deal of flexibility and can be used to make admin-
istration easier and more efficient. To create a new task pad, follow these steps:

1. Select the desired snap-in in the console. Then, select New Taskpad View from the
Action menu.

2. The New Taskpad View Wizard appears. Click Next on the Welcome screen.

3. In the Taskpad Display window, select a style for the task pad. You can choose from a
vertical list, a horizontal list, or no list at all. The wizard displays an example of each
style as you select it. Select an option, and click Next.

4. In the Taskpad Target window, you can indicate whether you want to display the entire
selected tree item in the task pad or whether you want the task pad to include all items
in the tree that are the same type as the selected one. Select an option, and click Next.

5. The next window enables you to configure a name and a description for your new task
pad. Type this information and click Next.

6. A summary window appears, describing your new task pad. A check box allows you to
immediately open the New Task Wizard. Leave this checked, and click Finish.

7. Your task pad is created, and the New Task Wizard appears. Click Next on the Welcome
screen.

8. On the Command Type window, you have three options:

• Menu Command—This indicates that you want to configure a task that runs a
menu command within the MMC.

• Shell Command—This allows you to configure a task that runs an operating
system command, such as a script, another application, a Web page, or another
command-line task.

• Navigation—This enables you to create a task that automatically navigates the
MMC to one of the items in your Favorites list.



I will configure a Navigation command as an example. You can experiment with the
other command types. You’ll find that they are pretty self-explanatory. After selecting
your command type, click Next.

9. The Navigation Task screen appears if you chose to create a Navigation-type command.
Simply select the favorite to which this command will navigate, and click Next.

10. The Name and Description screen appears, allowing you to configure a name and
description for your new task. Enter the information and click Next.

11. The Task Icon screen enables you to select an icon to represent this task. Select an icon
and click Next.

12. The wizard concludes with a summary screen that shows you the tasks currently config-
ured on the task pad. You can select the check box to immediately create a new task. In
this example, I’ll clear the check box and click Next to finish the wizard.

When the wizard has finished, you have a complete task pad, along with the tasks you created
shown as icons along the bottom of the task pad.

You can edit your task pad by selecting Edit Taskpad View from the Action menu.

Configuring Console Options
In addition to allowing you to change the console’s operating mode, the Options dialog box
allows you to specify three important options for consoles running in a User mode. These three
options are

• Enable Context Menus on Taskpads in This Console—This feature enables context
menus for task pad views. Turning off this feature prevents users from obtaining context
menus in task pads.

• Do Not Save Changes to This Console—This option prevents users from saving any
changes they make to a console. The next time they open the console, everything will be
as it was when you originally configured it.

• Allow the User to Customize Views—As I described previously, the details pane of
some snap-ins can be customized. Selecting this option enables users to customize their
views; clearing this option forces users to work with the view you set up when you saved
the console.


